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GENERAL ENGLISH

Dire_ctions : For Questions no. 36 to 38, an

idiom or phrase has been used in the sentence.

You have to choose the sentence which explains

the correct meaning of that and shade/darken

the correct answer in your answer sheet.

181

Example :

Tejas attends Karate classes once in a

blue moon.

(1) Tejas attends Karate classes
regularly.

(2) Tejas attends Karate classes rarely.

(3) Tejas attends Karate classes
fortnightly. '

(4) Tejas attends Karate classes
frequently but not regularly.

Explanation :

The answer is Option (2) as the

underlined part means ‘rare occurrence of

something’. So you have to choose Option

(2) and shade/darken the corresponding

answer In your answer sheet for this

example.

For more updates
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36.

37.

The Managing Director announced that
he was quitting because he does not
want to be an executive in a lame duck.

1) The Managing Director announced
that he was quitting because he does
not want to work in a position where
no one else can match his calibre,

2) The Managing Director announced
that he was quitting because he does
not want to work in an organization
where he is not drawing the salary
commensurate to his competence.

3) The Managing Director announced
that he was quitting because he does
not want to involve himself in the
unfair business model of the
organization;

4) The Managing Director announced
that he was quitting because he does
not want to be an executive who is
disabled and unsuccessful in the

organization.

He had to kick his heels for nearly an
hour when he went to that firm for an
interview.

1) He had to wait and pass the time
aimlessly for an hour when he went
to that firin for an interview.

2) He had to negotiate his terms and
conditions for working for an hour
when he went to that firm for
interview,

3) He had to discuss his salary and
perks for an hour when he went to
that firm for an interview.,

4) He had to face the group discussion
for around an hour when he went to
that firm for an interview.



https://careerkannada.com/

38.

Directions : Questions no. 39 to 42 are based |

Now the management has understeod
that the new employee is diamond in
the rough.

1) Now the management  has
understood that the new employee
may be competitive but couldn’t
undertake the task and finish it.

2) Now the management has come to
know that the new employee is good
at heart and the competence doesn’t
matter.

3) Now the management has realized
that the new employee is a rich
fellow and working as he wants to
sharpen his skills.

4) Now the management has realized
that the new employee has
exceptional qualities when it comes
to work and he is really an asset to
the company.

on completion of idioms. Fill in the blanks with
the most appropriate word/words from the

given alternatives

and shade/blacken the

corresponding circle accordingly in your answer

sheet.

181

Example :

Birds of a feather
(1) fly in a formation
(2) flock together
(3) fly high
(4) flock in wildnerness

Explanation :

Since Option (2) is the correct choice for
the above shade/blacken
Option (2) in your answer sheet for this
example.

guestion,

39.

41,

42.

For more updates
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Let bygones
1) be bygones
2} come upon
3) move on

4) hangon

Jack of all trades master
1) of one

2) of none

3) tobe done

4) of someone

A thing of beauty is

1) an eternal glimmer
2} ajoy forever

3) adiamond

4) so good to hear

All roads lead
1) to home
2y toRome

3) everywhere

4} tonowhere
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Directions : In Questions no. 43 to 46, each
question contains a paragraph of 6 sentences.
The first and the sixth sentences are given in
the beginning and end and numbered 1 and 6
respectively. The four sentences in the middle
are jumbled and labelled P, , R and S. You
must identify the proper order of these four
sentences and shade/blacken the option that
correctly identifies this sequence.

181

Example :
1. Once upon a time there lived a king.
P. One day while hunting he was
attacked by a tiger.
Q. He had three ferocious hunting
dogs.
R. The dogs pounced on the tiger and
saved the king’s life.
3. The king used to take them with
him while going out.
6.

He loved them till the end of his life.

The correct sequence is

ey
(2)
(3)
(4)

PQSR
RQSP
QSPR
SRQP

Explanation :

The correct sequence or order in this

example is

QSPR. So you have to

- shade/blacken Option (3) in your answer

sheet,

43.

For. more updates
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1)

2)

3)

4)

There are various rights of a

banker.

These have been vested by the law

of the country.

The account holder is authorized to
operate the account through a third
person, in addition to himself, by
suitable authority for one-time basis
and/or also for various functions

through a power of attorney.

Such rights and obligations under
the

mandates and power of attorney.

~special  relationship  are

Along with the rights, there are
certain obligations too which a
banker is required to fulfil.

Such power of attorney is either

general or special in nature.

SPRQ

RQPS

RSPQ

SPQR
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1.

1)
2)
3)

4)

Agents and corporate agents are key

distribution channels to any insurer.

this, the IRDA has

prescribed minimum educational

Towards

qualifications at the point of entry
and practical training followed by

an examination,

Development of these agencies must

be on the best professional lines.

IRDA has also lowered the required
minimum educational qualification
for rural agents to pass in the tenth

standard examination.

To aid the growth of insurance
selling in rural and non-urban
centres,  compulsory targets which
individual insurers are required to

fulfil have beén prescribed.

It has the

Insurance Institute of India to

also encouraged

conduct qualifying examination for
the agents and to bring out books
and training material in various

verngcular languages.
PQSR
QSRP
QSPR

QPSR

46.

For more updates

www.careerkannada.com

1)
2)
3)
4)

1)
2)
3)
4)

The fox and the crane were friends
for a long time.

She served the food in a beaker to
the fox. The fox could not eat it
because the beaker was having a
cylindrical neck which was very
high.

The crane could not eat the food
because of its long beak. The next
day it was the crane’s turn to host a
lunch for the fox.

But the fox wanted to show that he
was cleverer than the crane,

So one day he invited the crane for a
dinner and served the food on the
plate.

The fox realized his mistake, put
down his head in shame and went
away.

SRQP
RSQP
SQPR
RSPQ

Unemployment is a burning problem
and a big challenge for the country
today.

They do not get proficiency in
technical line.

The result is youth of our country
roam around without any job.

Qur universities produce more job
seekers than jobs available in the
country.

Young men and women mostly want
office jobs.

The incidents of thefts and other
unsocial acts are due to
unemployment.

SPRQ

RQSP

RSPQ

RQPS
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Directions : In Questions no. 47 to 50, there
are sentences which are divided and numbered
into three parts, and one of the parts may
contain an error. Identify the error by (1), (2) or
(3) given under the parts of the sentence. If
there are no errors,
Shade/blacken the corresponding circle in your
answer sheet. '

47.
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mark (4) No error.

Example :

Neither he
(1D

nor his team

(2)

were present that day. No error.

(3) (4)

Explanation :

The correct answer in this case is Option
(8). It should be “was present that day”.
So you must shade/blacken Option (3) for

this question in your answer sheet,

None of the six-qualiﬁers

(1)
who have been given a chance

(2)

to join this team play confidently.

(3)

No error.

(4)

48.

49,

50.
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Not only the doctor but also the nurses

(1)

of this nursing home is very kind

(2)

and helpful to the attendants. No error.

(3} (4)

The lawyers face the

(1)

same problems in their day-to-day lives
(2)

as do an ordinary man of our society.

(3)
- No error.
(4)
If Mahatma Gandhi
(1)

was alive he would start weeping

(2)

to see the present condition of India.

(3)

No error.

(4)
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Directions : For Questions no. 51 to 53, a

passage has been given. In the passage, some of |

the words have been left out. You have to read
the passage and try to understand what it is
about. Then fill in the blanks with the help of
the options given below it and shade/darken
the appropriate circle in your answer sheet.

Suddenly, Royal
Bangalore (RCB) lost wickets in a heap. Chris
Gayle went followed by Virat Kohli and A.B. de
Villiers. Another collapse seemed

(51) . Watson batted on to reach 88, his
highest T20 International score to date. Then,
as if it was scripted, he fell to Zaheer Khan in
the last over of the match, with Maxwell
pulling off an acrobatic catch behind the

Challengers

stumps. The stadium (52} . Every spectator
around the Kotla Stadium was on his feet,
applauding and cheering Watson as he
walked (53} like a gladiator who's just won
another battle.

51. What is the correct answer for the Blank
(51) ? Select from the options given
below.

1} doubtful
2} menacing
3} imminent
4) throwing
52. What is the correct answer for the Blank

(52) ? Select from the options given
below. '

1) exploded
2) disabled
3) crunched
4) wrecked

For more updates

What is the correct answer for the Blank
(53) 7 Select from the options given
below.

1} in

2} off

3) on

4) along

Match the following sentences with the
figures of speech used in them :

A. He was faster than the speed of
light.

B. Life is like a box of chocolates; you
never know what you're going to
get.

- C. War is peace. Ignorance is strength.

Freedom is slavery.

D. The tree quaked with fear as the
wind approached.

Figures of Speech :
I. Similie

II. Oxymoroh

ITI. Personification
IV. Oxymoron

V. Metaphor

Select the code. for the correct answer
from the options given below: '

A B C D
I II v IT1
2) It 1 v III
3 vV 1 o Iv
4 Vv 1 v III

Add a suitable question tag to the
sentence given below.

“The laws are certainly in favour of the
particular class.”

1) aren’tthey?
2) are they ?

3 isn’tit?

4) isit?

181 www.careerkannada.com
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Directions : For Questions no. 56 and 57, in
each of the following questions, a sentence has
been given in direct/indirect speech. Out of the
four alternatives suggested, select the one which
best expresses the same sentence in
indirect/direct speech and shade/blacken the
corresponding circle in your answer sheet.

56. Rajesh said, I bought a car yesterday.’

(1) Rajesh said that I have bought a car
the previous day.

(2)  Rajesh told that he had bought a car
yesterday.

(3) Rajesh said that he bought a car the
previous day.

(4) Rajesh said that he had bought a

car the previous day.

57. The teacher said, ‘Be quiet boys.’

(1) The teacher said that the boys
should be quiet.

The teacher called the boys and
ordered them to be quiet.

The teacher urged the boys to be

quiet,

(2)
(3)

The teacher commanded the boys
that they be quiet.

Directions : Questions no. 58 to 61 consist of
sentences with a blank in each. You have to
choose the best answer which can be filled in
the blank space and shadel/blacken the
corresponding circle in your answer sheet.

58.

(4)

The earthquake the people so
suddenly that they had no time to rush

out of their homes.

(1) cameout
(2) broke out
(3) came upon
(4) come on

For more updates
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61.

59. My brother not only has principles but is

capable of for them.
(1) standing up

{2) standing on

(3) standing with

(4) standing upon

60. As the girl was beautiful, the suitor could

not his eyes from her.
(1) take of
(2) take after
(3) take off
take with

(4)

If one works very very hard, day and

night, it will one’s health.

(1) tellon
(2) tell to
(3) tell upon
(4) tell out

Directions : For Questions no. 62 and 63, a
sentence has been given in Active or Passive
voice, out of the four alternatives suggested,
select the one which best expresses the same
sentence in Passive or Active voice and
shade/blacken the corresponding circle in your
answer sheet.

.62, Isaw him conducting the rehearsal.
(1) He was seen conducting the
rehearsal.

I saw the rehearsal to be conducted
by him.

(2)

(3)

He was seen by me to conduct the
rehearsal.

(4)

I saw the rehearsal being conducted
by him.
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63. His pocket has been picked.
(1) They have picked his pocket.
(2) Picking has been done to his pocket.
(3) Picked has been his pocket.
(4) Someone has picked his pecket.
64. What is the synonym of Conjecture ?
(1) Grave
(2) Outward
(3) Guess
(4) Claim
65. What is the synonym of Admonish ?
(1) Warn
(2) Cajole
(3) Encourage
(4} Abdicate
66. What is the antonym of Exodus ?
(1) Influx
(2) Home-coming
(3) Return
(4) Restoration

Directions : Read the following passage and
answer the items that follow (Questions no.
67 to 70). Your answers to these items should be
based on the passage only.

Passage

Anthropologist Edward Hall identified
two distinet ways in which members of various
cultures deliver messages. A low-context
culture uses language primarily to express
thoughts, feelings, and ideas as clearly and
logically as  possible. To  low-context
communicators, the meaning of a statement is
in the words spoken. By contrast, a
high-context culture relies heavily on subtle,
often non-verbal cues to convey meaning, save
face, and maintain social harmony.
Communicators in these societies learn to
discover meaning from the context in which a
message is delivered including the non-verbal
behaviours of the speaker, the history of the
relationship, and the general social rules that
govern interaction between people. When
delivering difficult or awkward messages,
high-context speakers from countries including

181

India, Japan and Korea often convey meaning
through context rather than plainly stated
words to avoid upsetting their hsteners.
Mainstream culture in the United States and
Canada falls toward the low-context end of the
scale. Long-time residents generally value
straight talk and grow impatient with “beating
around the bush”. By contrast, most Middle
Eastern and Asian cultures fit the high-context
pattern. In many Asian societies, for example,
maintaining harmony is important, so
communicators avoid speaking directly if that
would threaten another person’s dignity.

67. What are the aspects that are taken into
consideration by high-context cultures in
- their communication ?

A. The non-verbal behaviours of the
speaker.

B. The history of the relationship.

C. DPlainly stated words without
context and non-verbal cues.

D. The general social rules that govern
interaction between people.

() A, CandB

2) B,CandD

(3) A,BandD

(4) A, CandD

What does not come under a major
concern of low-context cultures ?

(1) Language

(2) Vocabulary

(3) Non-verbal cues

(4) Words

Who contributed to the study of high and
low context cultures ?

{1} Jacques Derrida

(2) Edward Hall

{3) Jacques Lacan

(4} Edward Said

Which among the following is not a
country that relies on high-context
cultures ?

(1) India

(2) USA

(3) Japan

(4) Korea

68.

69.

70.
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COMPUTER KNOWLEDGE
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COMPUTER KNOWLEDGE

All the numbers between 0 to 100 have
to be displayed in red colour. Which of
the following may be used to do that in
MS Excel ?

A. Use=if{) function to Format the
required numbers red.

B. Apply Conditional Formatting
Command on Format Menu.

C. Select the cells that contain
numbers between 0 to 100 then
click red colour on text colour tool.

Which of the options given above is/are
correct ?

Select the code for the correct answer
from the options given below :

(1) AandBonly
(2) Band Conly
(3) Bonly

(4) A, BandC

Which of the following can you paste

selectively using Paste Special

Command ?

A. Validation
B. Formats
C. Formula

Select the code for the correct answer
from the options given below :

(1) Aonly

(2) Aand Bonly
(3) Aand Conly
(4) A BandC

For more updates
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A B C D E F
1y 1 I o v vV VI
2 m [ IV I VI V
@ 1 O Iv m v VI
4 I I I Iv VI V

What happens if you select the first and
second slides and then click on the New
Slide button on toolbar in Microsoft
PowerPoint ?

" (1) A new slide is inserted as first slide
- in presentation.
(2) A new slide is inserted as second
slide in presentation.
(3) A new slide is inserted as third shide
in presentation.
(4) No slide will be inserted anywhere

and a pop-up will be flashed

displaying an error message.

Maich the file extensions (List I) with
the type of the file (Last I} :

List] List IT
{File Extension) (Type of File)
A srs I. Source Resource
String file
B. .src 1. Screen Resource
String file
C. xltx I11. Excel workbook
xlsx TV. Excel template
E. .ttf V. Storage file for
gallery
. .thm VL Font file

Seleet the code for the correct answer
from the options given below :

www.careerkannada.com
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What is cold boot of the computer
system ?

(1) A computer is turned off and then
turned back on when the power
the

supply to computer is

interrupted.

(2)

The computer’s operating system is
changed.

3)
from the system when the power
the

supply to computer 18

interrupted.

(4) A computer program is reinstalled
from the system when the power
supply to the

interrupted.

computer is

You can use drag-and-drop to embed

Excel worksheet data in a Word
document
(1) By dragging a range of Excel data to

the Word button on the taskbar
while pressing the Ctrl key.

(2) By dragging a range of Excel data to
the Word button on the taskbar
while pressing the Shift key.

(3) By dragging a range of Excel data to
the Word button on the taskbar

while pressing the Alt key.

(4) None of the above

A computer program is uninstalled |

7.

78.
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Match the generation of computers
(List I) with the systems used in the
machine (List IT) :

List I List IT
(Generation of (Systems used in

A. First I. Diodes and
transistors

B. Second II. Microprocessors

C. Third ITI. Integrated
Circuits

D. Fourth - IV. Vacuum tubes

Select the code for the correct answer
from the options given below :

A B C D
(1 II v IT1 1
(2) 1I I v 1
@) Iv 111 I II
4) IV I III I

Consider the following statements :

A. Java programming language was
created by James Gosling.

B. C language was developed by
Dennis Ritchie for the first time.

C. C++ prbgramming language was
developed by Bjarne Stroustrup.

D. FORTRAN language was designed
" by John Backus.

Which of the statements given above are
correct 7 :

Select the code for the correct answer
from the options given below :

(1) CandD only
(2) A, Band C only
(3) A, Cand D only
(4) A,B,CandD
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A. =AVERAGE(4,5,86,7)
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ASCII and EBCDIC are popular
character encoding codes and their full
forms are given below :

A. ASCIl - American Standard Code
for Information Interchange

B. EBCDIC - Extended Binary Coded
Decimal Interchange Code

Which of the above is/are correct ?

Select the code for the correct answer
from the options given below :

(1)
(2)
(3)
(4)

A only

B only
Both A and B

Neither A nor B

Which of the following is/are the correct
method/s for using AVERAGE function

in Excel ?

A. =AVERAGE(4, 5, 6,7)

B. =AVERAGE(A], B1, Cl)
C. =AVERAGE(AL:A9, .Bl:BQ)

Select the code for the correct answer
from the options given below :

(1) Aand Bonly
(2) Band Conly
(3) Bonly

(4) A, BandC

For more updates
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Match the Computer Languages (List D
with their applications (List II) :

ListI List IT
(Computer (Application)
Language)

A. FORTRAN I. In finance and
administrative
system for
_ companies
B. COBOL II. Application in
. education and
special language
for non-science
students

HI. Implementing
system software
and developing
portable
application

softwares

C. C-Language

D. BASIC . In computational
Physics and

Chemistry

Select the code for the correct answer
from the options given below :

A B C D

(1 1 v I 1
(2) 1 III v I
3 IV HI I IT
4) IV I I IT

Which of the following tools enables you
to add a text to a slide without using the
standard placeholders ?

(1)
(2)
(3)
(4)

Text tool box
Line tool
Drawing tool
Auto shapes tool
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In Microsoft Word, you can force a page
break

(1) By positioning your cursor at the
appropriate place and pressing the

F1 key

(2) By using the Insert/Section break

on the Insert tab

(3) By positioning your cursor at the
appropriate place and pressing

Ctri+Enter

(4) By changing the font size of your

document

Consider the following statements :

A.  Shorteut key to open font dialogue
box is Ctrl + F.

B. Shortcut key to centre align the
selected text is Ctrl + E.

C. Shorteut key for a spellcheck in a
document is F7.

Which of the statements given above are
correct ?

Select the code for the correct answer
from the options given below :

(1) A and Bonly
(2) BandConly
(3)  AandConly
4) A BandC

86.
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To copy formatting from one area in a
worksheet and apply it to another area,

you would use :

(1) The Edit>Copy Format and
Edit>Paste Format commands from

the menu

(2) The Copy and Apply Formatting

dialog box, located under the

Format>Copy and Apply menu

(3) There is no way to copy and apply
formatting in Excel — You have to

do it manually

The Format Painter button on the

(4)

standard toolbar

You can select a gingle range of cells in
MS Excel by

(1) Clicking the upper-left cell in a
group of cells and then pressing the
Shift key while clicking the lower
right cell in a group of cells

(2) Pressing the Ctrl key while

dragging over the desired cells

(3) Pressing the Shift key and an Arrow

key

(4) Dragging over the desired cells
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87. Match the MS Excel function
key shorteut (ListI) with  the
corresponding actions (List 1) :

ListI List I
(Function Key (Action)
Shorteut)

A F1 I. Activates the
selected cell for
editing

B. F2 II. Opens the help
menu

C. F4 III. Performs  spell
check in selected
range

D. F7 IV. Repeats last
action

V. Refreshes
workbook.
Performs
calculations on
formula

88,

181

Select the code for the correct answer
from the options given below :

(1)
(2)
(3)
(4)

A B C D

II I IV III
I I v v
v v III 1I

II I11 I v

Consider these two operators :

o

Which of the following is correct ?

(1)
(2)
(3)
(4)

Ais AND and B is OR
Ais AND and B is NOR
Ais OR and B is NOR
A is NAND and B is OR

89. Match the following symbols of the
flowchart (List I} with what they report

(List I} :

List I1

Indicates a delay
in a process

Indicates a
decision point
between two or
more paths in a
flowchart

. Can represent any

type of datain a
flowchart

Indicates any
processing
function

Indicates any type
of stored data

Logical OR

Select the correct code from the options

given below :
A B
(1 1 II
(2) II v
3) I \%
(4) II v

For more updates
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111
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The method of dividing a physical
channel into many logical channels so
that a number of independent signals
may be simultaneously transmitted on it
is referred to as

(1) Multithreading
(2) Multiprocessing
(3) Multiplexing

(4) None of these

Which of the following statements is not
true ?

(1) You ean type a text directly into a
PowerPoint slide but typing in text
box is more convenient.

(2) From Insert menu choose Picture
and then From File to insert your
images into slides.

(3) You
presentation in

can display a PowerPoint
Normal, Slide

Sorter or Slide Show view,

(4) You can show or hide Task Pane
from View >> Toolbars.

‘What are the three options available in

Picture Menu in Microsoft

PowerPoint ?
(1)
(2)
(3)
(4)

Insert

Clipart, Pictures, Shapes
Clipart, From File, Shapes
Clipart, From Files, AutoShapes
Clipart, Pictures, AutoShapes

93.

95.
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What is ‘Motion Path’ in Microsoft
PowerPoint ?

(1) A path to move items on a slide

(2) A path where PowerPoint files are

saved

(3) A path where PowerPoint program

is installed

None of the above

4)

Holding down the Shift key and rotating
the image will rotate in increments of

(1) 10 degrees
(2) 15 degrees
(3) 20 degrees

(4) 25 degrees

For an algorithm the complexity of the
average case is

(1)

Much more complicated to analyze

than that of worst case

(2)

Much more simpler to analyze than

that of worst case

(3) Sometimes more complicated and
some other times simpler than that

of worst case

(4) None of the above
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Linked lists are best suited

(1) For relatively permanent collections
of data

(2) For the size of the structure and the
data in the structure are constantly
changing

(3) For both of the above situations

(4) For none of the above situations

Which of the following memories has the
shortest access times ?

(1)
(2)
(3)
(4)

Cache memory

Magnetic bubble memory
Magnetic core memory
RAM

Consider the following versions of
Microsoft Windows :

A, Windows Vista
B. Windows XP
C. Windows 7

D. Windows ME

Put them in the chronological order of
their release.

Select the correct code for the answer
from the options given below :

(1) D,B,AC
(2) B,ACD
(3) A,BCD
(4) B,ADC

100.
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What is the function of an Assembler ?

(1)

To convert basic language into high
level language

(2)

To convert machine language into
high level language

3

To convert assembly language into
machine language

(4)

To convert assembly language into
high level language

Consider the following statements :

A. Maximum zoom percentage in
MS Word is 500%.

B. Maximum zoom percentage in
MS Excel is 400%.

C. Maximum zoom percentage In
Microsoft PowerPoint is 400%.

Which of the above statements is/are

true ?

Relect the code for the correct answer
from the options given below :

(1) Aonly

(2) A and B only

(3) B and Conly

(4) A,Band C
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